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Minutes of April Meeting
By Nancy Carpenter, Chapter Secretary

The April meeting was a joint event with
the Pittsburgh Markup Language Users
Group (Pittmark). Two speakers, Jeff Beal
from ANSYS and Bill LeRoy from USAirways
discussed why and how they use XML to
create, maintain, and publish their techni-
cal documentation. Both firms maintain
huge document sets and need to publish in
both printed and online format. They faced
the problems of cost, consistency, long-
term maintenance, and timeliness and found
XML to be the solution. They also ac-
knowledge that there is a lot to learn when
you use XML, which can add an order of
magnitude of difficulty to good grammar
and sentence structure. But for these two
firms, the result has been worth the effort.
Details of these talks are contained in sepa-
rate articles in this issue of Blue Pencil.

A few definitions will aid you in understand-
ing Jeff and Bill as you read these articles.

· SGML, or standard generalized markup
language, is the parent of HTML and
XML.

· HTML, or hypertext markup language,
is used in most web pages to provide
basic formatting. The fancier elements
like navigation buttons and indepen-
dent frames are written using Java
script.

· XML, or extensible markup language,
is developed from SGML. Its purpose
is to support database management,
web applications, and document pub-
lication in printed and electronic for-
mats. It is being developed by the
Worldwide Web Consortium and is
reaching maturity, that is, a stage of
completion like a standard software
release. Many web developers predict
that it will replace HTML.

· DTD, or document type definition,
identifies the structure rules. Both
SGML and XML allow you to maintain
document structure in a DTD.

· XSL, or extensible style language,
transforms XML into the format you
require for your final output.

· XSL-FO, or XSL formatting object, is
used to convert the text for printing.

Pittmark is dedicated to the development
of XML. Membership is informal, no dues
are charged. Meetings are held monthly.
For more information, please contact

Alan Houser, STC Vice President at:

arh@groupwellesley.com

or contact Pittmark founder

Dave Mundie at:

mailto:mundie@anthus.com

(Continued on page 2)

Your E-mails and the I-R-S / Many Happy Returns
By Al Borowski

Email is quickly becoming one of the bigger
drains on corporate productivity and prof-
itability.

More specifically, the ineffective, improper,
and incorrect use of employee email on com-
pany computers exposes organizations to
wasted time, bad press, and the possibility
of legal action from seemingly innocent
forms of electronic communication.

The following set of questions can help you
determine your awareness of critical email
issues.

1. How much time do your managers and
executives waste reading or deleting email
messages they don’t want, need, or ask for?

2. How much time do your employees waste
trying to create, understand, or respond to

emails that are unclear, don’t get to the point,
and are poorly written?

3. How much time do employees waste read-
ing or forwarding non-business items?

4. Is your company at risk because you do
not publish or enforce a company policy or
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company standards for employee use of
your computers?

5. How many of your employees send emails
to co-workers in the next cubicle or take 30
minutes to compose a message they could
convey easier and more effectively in a five-
minute phone call?

6. Do you know how companies can dis-
criminate against you based on the emails
you send?

7. What do you know about “Internet ad-
diction?”

The title of this article - Your Emails and
the I-R-S / Many Happy Returns describes
what employees and employers need to
know about managing and using email on
company machines. I-R-S stands for Image
- Results - Security.

Image
People form an image of you or your com-
pany by how well you communicate in per-
son, on the phone, and in writing. That now
includes your email messages.

Communicating via email is not the same as
communicating in a chat room. It is also not
the same as composing a 10-page term pa-
per in school.

Email messages still require careful atten-
tion to spelling, punctuation, grammar, for-
mat, and tone. The tone of the message
needs to be positive, personal, and profes-
sional. If you wouldn’t use chat room smiley
faces and abbreviations in a letter to a cus-
tomer, don’t use them in your emails.

How well you communicate in an e-mail tells
a lot about your judgment, attitudes, and
skills. If hearing your email message read
on local or national news broadcasts scares
you, don’t hit the Send button.

Results
Most people don’t get results from their
emails because they do not understand one
basic fact. Most people don’t read emails.

Your E-mails and the I-R-S / Many
Happy Returns
(continued from page 1)

Business people scan or skim through
email.

For this reason, creating successful emails
demands the correct approach along with
specific techniques and strategies.

Three simple techniques will help you get
better results from your emails.

First, use paragraphs to separate main
thoughts. Avoid email messages that run
on for 10 sentences, all contained in one
paragraph.

To really impress your audience, keep para-
graphs short. No paragraph should ever
exceed five sentences. You should really
strive for three-sentence paragraphs.

Second, average 15 words per sentence.
Typical business writing averages between
20 and 24 words per sentence. Shorter sen-
tences help people scan or skim emails ei-

(continued on page 3)
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(continued on page5)

ther on the screen or on paper, if they choose
to print them.

Third, use a powerful Subject Line and first
paragraph to grab your reader’s attention
and keep it. The Subject Line and the email
address of the person sending the message
are the first two things people notice when
they receive an email.

The Subject Line needs to be descriptive
enough to allow readers to relate to the sub-
ject matter and distinctive enough to be
found quickly and easily at a later time.

Your first paragraph, unlike the paragraphs
in the body of the document, should never
exceed two sentences. Think of your open-
ing paragraph as the Executive Summary of
your message. Executive Summaries usu-
ally precede a long report and give readers
the purpose and scope of the report.

Your first paragraph may be all your audi-
ence ever reads. So you need to make it
specific, interesting, and focused on the
needs of your audience.

Security
Security becomes an issue to both employ-
ers and employees.

Employers need to understand that em-
ployee emails can become a legal nightmare.
Casual statements contained in emails can
become legally binding contracts. Viruses
unknowingly forwarded to your clients by
your employees can result in huge damage
claims.

Sexist, racist, or pornographic material cir-
culated on your company computers can
result in expensive and embarrassing law
suits.

Employees need to understand that emails
they create belong to and are immediately
available to everyone and anyone, includ-
ing people outside your organization. You
need to protect your security and maybe
your careers.

Careers and promotions are at stake be-
cause employers can now using employee

emails as a form of discrimination. Employ-
ers maintain the right and responsibility for
the information created and sent on their
computers. Thus, they have information
immediately available to them in a way pre-
viously unavailable.

Employers can now use company e-mails
to analyze the skills, attitudes and work
habits of employees. The content, style, and
timeliness of your emails give employers a
much better picture of your communicating
style, interpersonal skills, problem-solving
skills, and your attitudes and approaches
to co-workers, managers, and clients.

To protect yourself, never send sensitive,
confidential, or personal information via
email. If you do, you run the risk of having
your information forwarded to people
whom you may not want to see the infor-
mation.

The proper, effective, and safe use of email
can save time, get fantastic results, and help
grow businesses and careers. To get those
Happy Returns, your emails should always
reflect careful attention to your I-R-S, your
Image, Results, and Security.

Copyright 2002 Al Borowski, MEd, CSP,
PP used with permission of copyright
holder.

Al Borowski is a Certified Speaking Pro-
fessional who works with business profes-
sionals who want and need to influence
other business professionals. He works
with organizations who want to improve
productivity and profitability through fo-
cused employee development.

You can contact him at:

Priority Communication Skills Inc.  P.O.
Box 24505 Pittsburgh PA 15234

412-561-7628

Fax 412-561-7035

al@alborowski.com

Get the business communication Tip of the
Decade at his website:

www.alborowski.com

Author of How To Get It Right When You
Write and a new book, Beyond E-mail
Netiquette - Setting Standards For Success

Your E-mails and the I-R-S / Many Happy Returns
(continued from page 2)

TechComm

Experienced Technical Writer
Experienced Researcher

• Research Proposals

• Grant Proposals

• Contract Proposals

• Research Reports

• Articles

• Monographs

• Training Materials

Telephone: 412-343-2508
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ANSYS and XML Publishing
Speaker Jeff Beal, Documentation Tool Specialist
Minutes of April STC/Pittmark Meeting

By Nancy Carpenter, Chapter Secretary

ANSYS produces simulation software for
the mechanical engineering industry. The
firm has a huge document set – over 8,000
printed pages in 25 books. Portions are up-
dated and released with each new software
release in both printed and online versions.

Recently ANSYS had to decide whether to
conduct a massive conversion to an up-
grade of their publishing tool or lose their
documentation. They switched to
ArborText’s Epic, but to avoid having to
face this decision again, they converted the
text to XML. The writers still use Epic in
editing, but the document set is maintained
in XML.

Benefits
ANSYS has found many benefits in using
XML. First, a key benefit is the separation
of content from layout. Writers are free to
concentrate on content.

Second, customizaton of the document is
the central objective, and XML facilitates
customization of document structure. The
writers tag each element (such as heading,
text, list, glossary term, and definition) ac-
cording to its meaning. Then they define
the format in the DTD. XML contains some
nice flexibility that allows you to customize
content. For instance, an “entity” is similar
to a FrameMaker variable or a Word macro.
You define a variable, such as Customer
Name. Instead of typing the actual cus-
tomer name in a document that will go to
many customers, you use the variable Cus-
tomer Name. Then for customer X, you give
Customer Name the value Customer X. An-
other feature, “profiling,” is similar to con-
ditional text. A paragraph that is profiled
can be shown in one manuscript and not
shown in another.

Third, XML allows true portability, which
ANSYS has achieved. In most conversions,
you lose something; not in XML. Docu-
ments can be edited in any editor that can
export in XML. They can be sent to be trans-

lated or printed without loss, although
ANSYS has not yet been able to take ad-
vantage of this feature.

Fourth, XML makes a database of a docu-
ment and describes segments with a rich
variety of information. For instance, you
can search for a word or phrase based on
the format in which it is used (such as list or
paragraph), the words that are around it,
and the tags that it uses. During a recent
software update, this allowed ANSYS to
easily change descriptions of menu paths.

Finally, more and more software is now sup-
porting XML. You can write in a generic
editor like Notepad, but many word pro-
cessing packages now produce acceptable
XML. Best, however, is the stand-alone
editor, since this type is the best developed
and most usable. Many stand-alone edi-
tors have a preview feature so you can see
the actual output and a good user interface
so the writing does not feel like program-
ming. There are good style sheets (DTDs)
available for conversion to final output.
ANSYS uses DocBook as their DTD. They
can produce Oracle Help, JavaHelp, UNIX

(continued on page 5)
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Help, Windows Help, and HTML. They use
HTML for the web-based documents. Be-
cause the documentation requires a team
of writers, ANSYS uses a content manage-
ment program. And some of the good sup-
port software is free or inexpensive.

Drawbacks
There are a few drawbacks to XML, fore-
most of which is the steep learning curve.
The editing packages are not user-friendly
and are fairly costly. XML is a paradigm
shift from WYSIWYG (what you see is what
you get) to WYSIWYM (what you see is
what you mean). It requires a different way
of seeing a manuscript, and here is where
the learning can be difficult. The writer must
learn the syntax, which involves the pur-
pose of the tags and the context in which a
tag can be used, must learn the attributes
that can be applied to a tag to affect format
and content, and must learn ANSYS inter-
nal usage guidelines. And because XML is
not what-you-see-is-what-you-get, you
cannot see what you are getting. ANSYS
writers do, however, have the compiling
tools on their computers so that they can
check the final output periodically.

(Another possible drawback  in a small
company is that the editors need program-
ming support to run the conversions and
to adjust the DTD and other publishing
support software. – Editor.)

Two minor difficulties are that the editors
must enter the review changes, and print
production is still difficult, although when
XSL-FO is refined, this should become easy.

Jeff Beal is a recent graduate of Carnegie
Mellon University in Computer Science.
He processes all the XML documentation
for ANSYS. This involves conversion to a
format that the printer can accept, conver-
sion to online format, and programming
to enhance the publishing tools. He can
be contacted at:

jeff.beal@ansys.com

ANSYS and XML
Publishing
(continued from page 4)

USAirways and XML Publishing

(continued on page 6)

Speaker Bill LeRoy, Manager of Flight Manual Services, FlightSpeaker Bill LeRoy, Manager of Flight Manual Services, FlightSpeaker Bill LeRoy, Manager of Flight Manual Services, FlightSpeaker Bill LeRoy, Manager of Flight Manual Services, FlightSpeaker Bill LeRoy, Manager of Flight Manual Services, Flight
Technical Operations, USAirwaysTechnical Operations, USAirwaysTechnical Operations, USAirwaysTechnical Operations, USAirwaysTechnical Operations, USAirways

Minutes of April STC/Pittmark Meeting

By Nancy Carpenter, Chapter Secretary

The Flight Bag
All airlines maintain a huge set of opera-
tions manuals called the Flight Bag that has
an urgent need to be timely, accurate, and
easy to use. It contains all the operating
instructions for the aircraft as well as infor-
mation on the landing approaches and situ-
ations that could occur during the flight.
Every flight crew takes the entire document
set on the flight and must be able to access
the correct information quickly. In addition,
non-pilot users such as office workers need
these manuals.

Until now, the flight bag  was maintained in
printed form at great expense.  To give you
an idea of the scope of the flight bag,
USAirways maintains 12,000 sheets of in-
formation, and updates it yearly.

The airline industry has struggled with its
documentation problem for years. In 1996,
the Digital Display Working Group was
founded with the objective of introducing
electronic information technology into the
cockpit. In addition, the Volpe Research In-
stitute of the US DOT researched the hu-
man factors that affect use of digital dis-
plays in flight. Their yardstick for evaluat-
ing an electronic flight bag will be released
soon.

A few airlines now use electronic flight bags
on laptop computers. United plans to be
paperless across the company in 5 years,
and they plan to accomplish this using
XML.

The Flight Operations Working Group is
proposing an SGML specification for data
interchange. This will coordinate well with
documentation efforts.

Self Assembly of Information
The future of aviation information is self
assembly of information – object oriented
retrieval that produces a brief operating

procedure geared specifically to the situa-
tion and predicts other information that
could be needed. When the flight crew con-
sults the flight bag, they need information
on the current task and on how it affects
the rest of the tasks through to landing.
USAirways is evaluating classic and XML
database applications to fill this need.

XML and the Electronic Flight Bag
USAirways is the first in the industry to
deploy an electronic library for flight op-
erations and, like United, will soon make it
XML-based. Eventually, their flight bag will
be web-based. KD Van  Drie of Electra Train-
ing Systems spearheaded a task analysis
for training programs that has been a key
element in the success of this program and
gives a robust starting point for develop-
ment of self assembly of information.
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Tools and Tips: PDF Primer
By Robert P. Mohr

Turning your Word documents into PDF (Portable Document Format) files is an excellent
way to share your documents with readers across a wide spectrum of operating systems
and hardware platforms. Adobe’s free Acrobat Reader makes it possible to read PDF files
on machines running Windows, UNIX, and Apple OS. A version of the Reader is also
available for handheld computers. So, how do you turn those beautifully crafted Word
documents into PDF files?

The process boils down to printing the Word document to a postscript file and then
“distilling” it to a PDF. Although there are a few shareware utilities and third-party services
that can create PDF files for you, I prefer to use Adobe Acrobat for all of my PDF work. It
automates the distillation process, integrates well with Microsoft Office, and is the best
way to customize a PDF file. More information is available at www.pdfzone.com.

After you install Acrobat, you’ll notice when you open Word that a 2-icon toolbar has been
added. There is also an Acrobat menu option on the main menu bar. Both of these are
supported by the PDFMaker suite of macros that are installed with Acrobat. (A similar
toolbar and menu option is also installed in PowerPoint and Excel.) The Acrobat menu
option allows you to configure the PDF output based on attributes in your Word docu-
ment. For example, selecting the Change Conversion Settings option on the drop-down
menu displays the Settings dialog box. Figure 1 shows the Bookmark options.

(continued on page 7)

USAirways and
XML Publishing
(continued from page 5)

Figure 1: Bookmark options

Darlene Mullenix, Treasurer
Darlene Mullenix has volunteered to serve as Chapter Treasurer.  Congratulations, Darlene,
and thank you.

There have been several steps in
USAirways’ path toward XML. First, they
studied the human factors research that
compared the efficiency of a pilot’s use of
paper versus electronic versus web-based
information and have decided that their fi-
nal objective is to become web-based.

Next, Flight Manual Services built an inter-
active PDF library. They needed the docu-
mentation to be similar to the printed set so
that the readers would find the new me-
dium acceptable. Because of the keyword
search and hypertext cross-references a PDF
can provide, this first step made the flight
bag much easier to use.

To reduce costs, they provided some of the
non-pilot users with CDs. The library is now
available on the Company intranet.

Next, they converted to SGML using
FrameMaker+SGML. In doing so, they had
to retype some old data and vowed never
to do this again. They are now converting
to XML using FrameMaker.

To move toward XML, Flight Manual Ser-
vices did a task analysis of all tasks that are
performed during a flight. They tagged the
information related to each task and devel-
oped a data structure to access this infor-
mation. Finally, they split the information
into objects that can be maintained cen-
trally. This reduces expensive duplication
in writing and increases the consistency of
structure, making the documentation easier
for pilots to understand.

When the flight bag becomes web-based,
USAirways plans to put a server on each
airplane to ensure reliable access.

Bill LeRoy is Manager of Flight Manual
Services for USAirways. He has been work-
ing on the electronic flight bag since its
inception in 1996. Bill can be contacted
at:

bill_leroy@usairways.com
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(continued from page 6)

Tools and Tips: PDF Primer

The term Bookmark here is different from a Word bookmark. PDF bookmarks appear as
dynamic table of contents entries when viewed in Acrobat Reader. They can be based on
your document’s heading or style structure.  Clicking the Display Options tab (Figure 2)
lets you control how links and bookmarks are displayed when the PDF file is opened.

Figure 2: Display options

Once saved, the settings remain in effect until you change them. You may find a need to
make changes to these on a document-by-document basis. The Settings, Security, and
Office tab settings are a bit more global in scope. I set them once and haven’t had a need to
change them since. To generate a PDF from a Word document, simply click the Convert to
Adobe PDF icon on the toolbar. PDFMaker prompts you for the PDF file’s name and creates
the file. If you’ve selected the View Result in Acrobat option from the Acrobat drop-down
menu, then Acrobat is automatically called by PDFMaker and displays the new PDF.

Once the file is in Acrobat, there are a myriad of tools with which you can put the finishing
touches on your PDF file. Here are just a few:

····· Select File > Document Security from the main menu to protect the finished file from
tampering. Using password protection, you can prevent readers from printing, copy-
ing, or altering the contents.

· Select File > Document Options to add document summary information and specify
the appearance of the PDF when it is opened.

· Select one of the Insert, Delete, Extract, or Replace pages under the Document menu
option to perform those operations on one or more pages. These are especially useful
when compiling a single PDF file (such as a book) from several (chapter) PDF files. Use
the Crop and Rotate options to alter a page’s appearance.

· Add a bookmark to the Bookmarks window at any time by selecting text from the
document (using the Text Select Tool icon) and pressing Ctrl+B. The bookmark entry
can be further modified by right-clicking on it and altering its properties.

· Delete a bookmark by right-clicking on it and selecting Delete from the shortcut menu.

(continued on page 8)

When Communicating
Information Matters

Penn State’s new Technical
Communications Certificate
program—coming March 2002

Penn State is committed to affir-
mative action, equal opportunity,
and the diversity of its workforce.
Produced by Outreach Marketing
Communications  
U.Ed.OCE 02-0423mkm/bjm

■ Find the right
words

■ Develop effective
editing strategies

■ Use items such
as tables to 
convey ideas

■ Build project
management
skills 

To find out how, please visit:
www.psutechcommcert.org/ofbp

Educational
Opportunities
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    WHEN : Friday, May 31, 2002,

     6:30-8:30 pm.

    WHERE :  To be announced.

· Rearrange the bookmarks and change their hierarchy by clicking on a bookmark and dragging it to the new location.

You can also add several dynamic and custom effects to a PDF file:

· Pop-up notes · Hyperlinks · Input forms
· Graphics · Video clips · Javascripts
· Highlighted text

If you want to create a PDF from an existing paper document, you’ll have to scan it:

Select File > Import > Scan

When scanned, the resulting PDF is stored as an “image” rather than text. You can save the PDF as is, but it will not be searchable. In order
to convert the scanned file into one that is text-based and searchable using Adobe Acrobat 5.0, you’ll need to download and install the
Paper Capture utility. You can obtain it at:

http://www.adobe.com/products/acrobat/pluginreg.html

After installation, a Paper Capture option appears on the Tools drop-down menu. Selecting the paper capture option invokes an optical
character recognition engine that scans through the file and creates words and numbers from the image. Graphics are ignored. The
accuracy of the conversion is usually very good, but you should review the contents before distributing the file.

Regardless of how you create your PDF files, or the modifications you make to them, PDF is an ideal way to distribute documents to a
diverse audience.

Bob Mohr is a senior member of STC and can be reached at:
rpmohr@writemohr.com.

Tools and Tips: PDF Primer
(continued from page 7)

Spring Fling, May 31
The date is set for May 31. All we need is you.

Join us to celebrate the end of the 2001-2002 season with eating, drinking,

networking, and socializing. Details will be announced on the Pittsburgh STC Web site at:

http:www.stcpgh.org

or you can contact Darlene Mullenix at 412-288-8676.
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